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About this Guide

Informatics for Integrating Biology and the Bedside (12b2) is one of the sponsored
initiatives of the NIH Roadmap National Centers for Biomedical Computing
(http://www.bisti.nih.gov/ncbc/). One of the goals of 12b2 is to provide clinical
investigators broadly with the software tools necessary to collect and manage project-
related clinical research data in the genomics age as a cohesive entity—a software suite to
construct and manage the modern clinical research chart.

Document Version History

Date Revision | Description Author(s)
10/26/2007 1.0 Version 1.1 Lori Phillips
11/27/2007 1.01 Update permission of scripts Lori Phillips
11/05/2008 1.1 Release 1.3 client changes Lori Phillips
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Prerequisites

Required Software

If you installed the prerequisite software from the Hive Installation Guide you may skip
this section. In addition, if you have previously installed the PFT cell under another
release there is no reason to reinstall or upgrade the PFT cell. Release 1.3 PFT changes
only affect the client software.

a. Java JDK

JDK 5.0 (recommended)

Download JDK 5.0 Update 11 (jdk-1 5 0 11-linux-i586.bin) from
http://java.sun.com/products/archive/

a)Install the SDK into a directory of your choice (/opt/java/jdk1.5.0 11,
/opt/java/jdk1.6.0_02, or YOUR JAVA HOME DIR)

b. Apache Tomcat 5.5 + JDK 1.4 Compatability Package
The PFT cell runs under tomcat. Download ‘apache-tomcat-5.5.23-compat.zip’

and ‘apache-tomcat-5.5.23.zip’ from
http://archive.apache.org/dist/tomcat/tomcat-5/v5.5.23/bin/

a)Unzip into a directory of your choice (/opt/apache-tomcat-5.5.23 or
YOUR TOMCAT HOME DIR)
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b) If default port 8080 is unavailable (another application is using this port), edit
‘YOUR TOMCAT HOME DIR/conf/server.xml’ file to reconfigure the non-
SSL HTTP/1.1 Connector to another port such as 7070 and the AJP 1.3 connector
to another port such as 7009

<!-- Define a non-SSL HTTP/1.l1 Connector on port 7070 =

<Connector port="7070" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enablelookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

<!-- Define an AJP 1.3 Connector on port 7009
<Connector port="7009"
enablelookups="false" redirectPort="8443"
protocol="AJP/1.3"/>

c)You may also need to update the run permission of the tomcat startup scripts.

‘chmod 775 YOUR_TOMCAT HOME_DIR/bin/*.sh’

c. Apache Ant 1.6.5

Download 'Apache Ant version 1.6.5' (apache-ant-1.6.5-bin.zip) from
http://archive.apache.org/dist/ant/binaries/

a)Unzip into a directory of your choice (/opt/apache-ant-1.6.5 or
YOUR ANT HOME DIR)

d. Apache Axis2 1.1

Download 'Apache Axis2 version 1.1', from
http://ws.apache.org/axis2/download/l 1/download.cgi and select the download
type WAR (Web Archive) Distribution.(axis2.war)

a)Create folder axis2 inside “'YOUR _TOMCAT HOME DIR/webapps’

b)Unzip axis2.war inside “YOUR TOMCAT HOME DIR/webapps/axis2’
folder.
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e. Update your environment variables

Be sure to set the JAVA HOME, ANT HOME and CATALINA HOME
variables to the JAVA, ANT and Tomcat home directories you set up in steps a-c
respectively. Examples are shown below.

# Sample environment variables

JAVA HOME=/usr/java/jdk1.5.0 11

ANT HOME=/opt/java/apache-ant-1.6.5

CATALINA HOME=/opt/apache-tomcat-5.5.23
PATH=$PATH:SANT HOME/bin:3JAVA HOME/bin
export JBOSS HOME

export CATALINA HOME

export JAVA HOME
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Install Server Software

Installing the Pulmonary Function Test Processing Application

If you have previously installed the PFT cell under another release there is no reason to
reinstall or upgrade the PFT cell. Release 1.3 PFT changes only affect the client
software.

1. Download and extract PFT server source code to a target area.

a) Set up a target source directory.

b) Extract PFT server source code to the target source directory

2. Ensure that Tomcat is not running

a) ./SCATALINA HOME/bin/catalina.sh stop'
3. Deploy from edu.harvard.i2b2.pft

a) 'cd source_directory/edu.harvard.i2b2.pft'

b) Edit the build.properties file and set tomcat.home property.

tomcat.home=YOUR TOMCAT HOME DIR

c¢) ant -fmaster build.xml build-all
d) ant tomcat-deploy
4. Start Tomcat

a) /SCATALINA HOME/bin/catalina.sh start
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5. Verify webservice is running

a) Check url ‘http://yourHost:7070/axis2/services/listServices’ in a browser.
Verify that PFTService is listed as active.

(Port will be the non-SSL HTTP/1.1 Connector configured during your
Tomcat installation.)

/2 List Services - Windows Internet Explorer ) Im] |
@A - I http:fiphsizbZzapptest.mah. harvward. edu: 7070/ axis2 services/listServices j 2| X ILive Search Bl
A £Y - ¥
w2k List Services | | f?} = [ - = - sk Page + (0 Tools -
. =
PFETService

Senice EPR - http://phsiZb2apptest. mgh_harvard edu:7070/axis2/senvices/PFTService
Senice REST epr - http://phsiZbZapptest.mgh_harvard .edu:7070/axis2/rest/PFTSenice

Service Description : PFTService J

Service Status - Active
Available Operations

+ getPulmonaryData

-
1] | »

|D0ne ’_ ’_ ’_ ’_ ’_ ’_ |® Internet H100% v g

6. Configure PFT cell information in gridsphere

This step is addressed in section 5, Global Hive Data of the Project Management
(PM) Cell/gridsphere installation and set up. Please refer to this document if the PFT
Cell has not yet been configured.

To verify this data, go to the site http://tomcatHost:tomcatPort/gridsphere.

Once logged on, select ‘Global Hive Data’ from the primary navigation tab and
‘Registered Cell’ from the secondary navigation menu. If the PFT Cell is listed, it
has already been configured. Select the PFT cell name and click on Edit Cell Info to
verify the PFT cell configuration.
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Changing Server log level

a) Edit SCATALINA HOME/cont/logging.properties to indicate ‘INFO’ or
‘DEBUG’. Logs appear in SCATALINA HOME/logs/catalina.out

E R
# Facility specific properties.
# Provides extra control for each logger.

G o

org.apache.catalina.core.ContainerBase. [Catalina].[localhost].level =
INFO
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Install Client Software

Installing the Pulmonary Function Test Processing Workbench
Plugin

PFT Release 1.3 client software is compatible with versions 1.2, 1.2.1 and 1.3 of the
12b2Workbench.
1. Locate your i2b2Workbench software’s i2b2workbench directory.

e.g. 2B2 WORKBENCH HOME/i2b2workbench

2. Download PFT plugin
a) Download edu.harvard.i2b2.eclipse.plugins.pft 1.3.0.jar

b) Place into your 2B2 WORKBENCH_ HOME/i2b2workbench/plugins
directory
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Verify Installation

PFT Cell Sanity Test via the i2b2Workbench

1. Configure the i2b2Workbench to communicate with your PFT cell.

This step is addressed in section 5, Global Hive Data of the PM Cell/gridsphere

installation and set up. Please refer to this document if the PFT Cell has not yet been
configured.

To verify this data, go to the site http://tomcatHost:tomcatPort/gridsphere.
Once logged on, select ‘Global Hive Data’ from the primary navigation tab and

‘Registered Cell” from the secondary navigation menu. If the PFT Cell has been
configured you will see the following:

/2 i2b2 Group Management Portal - Windows Internet Explorer -0l x|
@E}: - I': http:,l',l'phsi2b2apptest.mgh.harvard.edu:?D?DIgridspherej [#4 | % ILive Search | 2 [~
F . o »
W b #2 izbZ Group Management Portal | | - - (e vk Page - (O Tools -
"__.r - 4 National Center for Biomedical Computing Logout [l
.{_ I Welcome, i2b2
/ Informatics for Integrating Biology & the Bedside i

| weizeme || saministize || Deme || Globat Hive Data. |

Register new cells ar modify existing ones:

Data Repositony

Ontology Cell
FFT Celi
Edit Cell Info Remove Selectad
Add New Cell =
5
|Dcune l_ l_ l_ l_ l_ l_ |@ Inkernet HIE% v

To verify cell data, select cell name and click on Edit Cell Info.
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2. Launch the i2b2Workbench (double-click on i2b2Workbench.exe)
Login to i2b2:

a. Select your target location (YourSite)

b. Enter a valid username and password that you set up in gridsphere
(demo/demouser)

c. The URL at the bottom of the login screen should be the address of your PM cell.
If not, return to PM Cell installation procedures, section 7, Verify Installation.

Login to i2h2 X|

Enter UserID and Password

Target location: I"'"-:uurSiI:e j
User name: I demo

Password: I e

[~ start as demanstratian anly ll

Login I Zancel |

r‘uttp:,l',l't-:umu:atHu:ust:I:u:umn:atF‘u:urt,l'axisZ,l'rest,l'F‘MServin:e,l'
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3. Open the PFT view in the workbench

Window->Show View->PFT
Double-click on the PFT tab so it will consume the entire window.
Then click on the Load Sample button.

il
File ‘Window Help
FImEy. 5=
Repart |Results I Request XML I Response XML
Date: xx/xx/xx ;I
PT: DOE, JANE DATE: xx/xx/xx
PTH#: 12345678 AGE: &7 3EE: F HT: 63.0 in WT: 105.0 lh
PHYSICIAN: ZMITH TECH: AEBC
DIAGNOSIS: DYSPHEL
SME HE: NEVER
Pre-Drug*
Spirometry Predicted Aetual %Pred Aetual %Pred % Change
FvC (L) Z.58 Z.12 82
FEV1 (L) 1.97 1.51 76
FEV1/FVC (%) 7 71 92
FEF25-75% (L/3) 1.79 1.09 61
FEFmax (L/3) 5.18 Z.70 52
TET {SEC) 9.66
Pre-Drug*
TEEND REPORT
DATE TIME FViC FEV1 FEV1/FVC FEF25-75%
(L) (L] (%] (L/3)
{PRE} {PRE] {PRE] {PRE]
wx/xx/xx 08:25:40 2.12 1.51 71.36 1.08

Get Pulmonary Data | Clear Text |

IBWH PFT Report: 'l Load Sample |

o o

Next click on the Get Pulmonary Data button and wait for the PFT cell to process the
report.
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(@izb2 workbench i oy ]
File ‘Window Help
(wrrr x i
Report  Results |Request ML I Respanse XML |
Nare I Walue/Units Code
Height 3.0 inch LCS-I2BZ2:pulheight
Weight 105.0 pound LCS-I2BZ:pulweight
FEV1 Chserwved 1.51 liter LC3-IZBZ:pulfeviobs
FEV1 % of Predicted 76 percent LC3-I2BZ2:pulfevipred
FVC Chzerwved 2.12 liter LCS-IZBZ:pulfweohs
FVC % of Predicted 52 percent LCS-IZ2B2:ipulfvcpred
< | H

4. Possible problems

Processing errors are reported in the Results tab.

These include:

1. No PFT results were found.
Please verify that correct report was submitted for processing.

Also verify that the PFT web service is running (see section 2, step 5).

2. No PFT response generated.

Verify that the PFT web service is running (see section 2, step 5).

Verify that the correct PFT URL was entered into gridsphere.

3. No information in Name column

Verify that the ONT web service is running.

Verify that the correct ONT URL was entered into gridsphere.
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Importing the client source code

Importing the PFT project into the i2b2Workbench workspace

The PFT project software is contained in the Eclipse “Archive” file called PFT-client-src-
13.zip under edu.harvard.i2b2.eclipse.plugins.pft. Import this project into a workspace
containing version 1.3 of the i2b2 workbench.

File->Import->General->Existing Projects into Workspace
and select the archive file ‘PFT-client-src-13.zip’.

Building the PFT client source code

Open the buildFiles folder in the edu.harvard.i2b2.eclipse.plugins.pft project.
Right click on the file ‘master build.xml’ and select RunAs->2 Ant Build.
Select clean-all, build-all and run.

Refresh the edu.harvard.i2b2.eclipse.plugins.pft project within Package Explorer.
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edu.harvard.izb2z.eclipse.plugins.pft master_build.xmil

todify attributes and launch.
Run an &nt buildfile,

" bl .
@) clea...
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License

The 12b2 source code is licensed under the i2b2 Software License Software. This includes
but not limited to all code in the edu.harvard.mgh.i2b2.* package namespace.
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